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Overview of Q-Box RP2LP High Range Respiration Package:  

The Q-Box RP2LP package provides the user with all the materials required to measure the metabolic rate 

of medium-sized animals such as mammals, reptiles, and amphibians in an open-flow gas exchange 

system.    

The concentration of CO2 and O2 in the gas supplied to the flow-through animal chamber or flask is 

measured using a Q-S153 infrared CO2 gas analyzer (IRGA; 0 to 10%) and a fuel cell Q-S102 O2 Analyzer (0 

to 100KPa).  The gas is pumped at a measured flow rate (adjusted by the Q-P651 Gas Pump and Q-G265 
Flow Monitor) through the chamber containing the subject material.  The concentration of CO2 and O2 in 

the outflow gas is determined using the Q-S153 CO2 Analyzer and Q-S102 O2 Analyzer.  Analog signals 

from all the sensors are converted to digital signals via two integrated interfaces (6 available channels).  

Data are displayed, recorded and manipulated on a PC or Macintosh computer using Logger Pro software. 

Changes in the concentrations of CO2 and O2 in the outflow gas are monitored in real time.  Metabolic 
rate is calculated from the change in O2 and CO2 and the flow rate directly in the software using provided 

calculation templates.    

The Q-Box RP2LP also includes a temperature sensor (S132) which can be placed inside the animal 

chamber and allows investigations into the effect of temperature on metabolic rate.  Metabolic rates 

measured at different temperatures can be corrected to a standard temperature, assuming a given Q10.  

The Q-Box RP2LP Package can be used to investigate animal metabolic responses to exercise, to different 
diets, to the administration of pharmaceuticals and to various concentrations of O2 and CO2 in the gas 

supplied to the sample chamber.  Gas mixtures can be supplied via 2 large gas bags (G122 included with 

the system) or, for longer term experiments such as hibernation studies, from a compressed gas source.  

Other potential applications for the RP2LP package include measurements of human respiration and 

metabolic activity.  This requires the addition of a pneumotach spirometer, exercise heart rate monitor, 

face masks and accessories as supplied in the Q-Box HR1LP Human Respirometry Package.  

     

Components of Q-Box RP2LP:  

Q-S153 CO2 Analyzer (Range:  0-5% and 0-10%)   

Q-S102 O2 Analyzer with pressure sensor (Range:  0-25KPa and 0-100KPa)  

Drying columns for Q-S153 and S102 with Drierite (blue) (x3) (Q11784)  

CO2 scrubbing column with soda lime (white) (Q13025)  

Q-G265 Flow Monitor (Range: 0 -2 LPM)   

Q-P651 Gas Pump (3 LPM no load)  

G114 Flow-through Animal Chamber (8.5 cm ID x 20 cm)  

S132 Stainless Steel Temperature Probe  
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2 x G122 Large Gas Bag (30 Litres)  

G127 T-Piece Assembly (T-Piece, needle valve, tubing)  

F250 Flow meter  

Integrated C610 LabQuest Mini Data Acquisition Interfaces, 6 analog channels (x2)  

C901 Logger Pro Data Acquisition Software  

C404 Customized Setup Software  

Q-Box Accessory Kit (includes tubing, filters, connectors, wool, wrench for needle valve adjustment, small 

screwdriver for adjustment of analyzers, Qubitac sealant, vacuum grease, two-way valves x2 for switching 

between ref. and sample)  

Manual  

Individual power supplies for all the sensors (for use in stand-alone mode outside of the Q-Box)  

Rugged weather-proof case  

A249 Battery Pack for field work (OPTIONAL)  

  

  

Quick Start Up Steps:  

1. Load Logger Pro 3 software onto the computer (follow instructions on pg. 22).    

2. Load C404 customized files (follow instructions from pg. 24)  

3. Plug the Q-Box into a power supply (or into an optional A249 Battery pack for field use)  

4. Turn on the Q-P651 pump, Q-G265 flow monitor, Q-S153 CO2 analyzer and Q-S102 O2 analyzer  

5. Ensure that the Q-S153 is set for 5% range and Q-S102 is set for 25KPa range. 

6. Allow the Q-S153 CO2 and Q-S102 analyzers to warm up for at least 30 min or longer.   

7. Connect two USB cables from the Q-Box frame to the computer. Two audible sounds from the 

computer may be heard as the two interfaces are recognized.  Ensure that USB1 is plugged in 

first and USB2 is plugged in second.  This is critical in ensuring that the two interfaces are 
recognized in the correct order.  

8. Open the “Q-Box RP2LP Setup” file to start Logger Pro software.  The following screen will 
appear.  
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9. Assign the sensors to appropriate channels on the 2 interfaces as follows:  

a. Ch. 1 LabQuest Mini 1 = Q-S153 CO2 Analyzer (5%) 

b. Ch. 2 LabQuest Mini 1 = Q-S102 Analyzer Pressure (kPa)  

c. Ch. 1 LabQuest Mini 2 = Q-S102 O2 Analyzer (25kPa)  

d. Ch. 2 LabQuest Mini 2 = Q-G265 Flow Monitor 2LPM  

Note: Ch. 3 LabQuest Mini 1 automatically recognizes the stainless steel temperature sensor (S132 
Temperature). The configuration of the sensor connections is shown in the software at the bottom 

of page 1.  

 

Check the system plumbing by removing the tray with all the sensors from the Q-Box and 

place it outside of the box as shown in the photo below.   The system should be configured 

for calibration before it is used in experiments.  Ensure that a blue tubular filter is connected 
to the gas pump and Q-S153 “In” ports to prevent any particulate debris from entering the 

system. 
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Component Set-Up for Calibration   

Note: heavy blue lines indicate gas flow; thin black lines indicate electrical connections  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

10. The gas supply tubing from the gas source (gas bag or other constant source of CO2) is                 

attached to “In” port on the Q-P651 Gas Pump via a blue particulate filter.   

 

When studying the animal in air, the gas source can be a gas bag of CO2-free air (filled from a 

commercial tank) to avoid the significant fluctuations of CO2 in room air due to human breath. 
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An alternative is to use outside air which has a constant CO2 level of ~ 400 ppm. Outside or 

inside air can be scrubbed of CO2 using the soda lime column if CO2-free air is needed.  

Note: If the gas source is pressurized (e.g. tank) do not force pressurized gas into the pump.  

Instead, reduce the regulator pressure to 2-3 psi and connect the gas line to a luer “T” piece. 

Connect the pump to one of the other T ports and let excess gas vent from the third port of the 

T-piece. The pump then supplies gas at atmospheric pressure. 

 

 

 

 

 

 

 

 

11. The “Out” port of the Gas Pump connects to the “In” port of the Q-G265 Flow Monitor.     

Note: The manual 3-way valves are installed as in the above diagram to direct the flow of gas either 
through the animal chamber to obtain a measurement, or to bypass the chamber to obtain reference 
levels.  The two valves can be connected directly to each other as a unit to make valve turning easier. 
Tubing with male luer connectors at both ends is required for connecting the left valve to the 
chamber in the above diagram. 

 

 

 
 

 

12. The “Out” port of the Flow Monitor initially (in the calibration mode) connects to the “In” port 
of the Q-S153 CO2 Analyzer via the Drying Column (blue DRIERITE) and a blue filter.  

Note that only one drying column needs to be used when Q-S153 and Q-S102 are used in 

series unless gas entering the CO2 analyzer is high in water vapour.    
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i The “Out” port of the Q-S153 CO2 Analyzer connects to the “In” port of the Q-S102 

O2 Analyzer.  

ii Gas vents from the O2 analyzer via the “Out” port.    

iii Two blue filters (25µ) should be placed in the gas line, one before the pump and 

one before the CO2 analyzer, to prevent particulate matter from entering the 

analyzers.  

  

13. After initial calibration of the gas analyzers (see pg. 10 for instructions), configure the system for 
measurements of animal respiration in an open-flow system as outlined in the diagram below. 

When studying the animal in air, the gas source can be a gas bag of air (filled from a compressor) 

to avoid the significant fluctuations of CO2 in room air due to human breath. If possible, use 

outside air which has a constant CO2 level of ~ 400 ppm.  

Component Set-up for sample measurements in an Open-Flow system with flow rates < 650 ml/min:  
 

 

 

 

 

a. Attach the “Out” port of the Flow Monitor to the inlet of the animal chamber.    

b. Attach the outlet of the animal chamber to the inlet of the drying column   

c. Attach the outlet of the drying column to the “In” port of the Q-S153 CO2 analyzer 

via the blue filter.  

d. Attach the “Out” port of the Q-S153 CO2 analyzer to the “In” port of the Q-S102 

O2 Analyzer.    

e. The “Out” port of the O2 Analyzer vents the gas in the Open-Flow System.  

f. For experiments in which flow rates through the animal chamber need to be 

higher than 650 ml/min, the system should be configured with a T-Piece flow 

bypass.  Note that flow rates higher than 650 ml/min through the CO2 and O2 
analyzers can damage the analyzers.  See the diagram below for the set up with 

the T-piece bypass.  
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Component set-up for sample measurements in Open-Flow system with flow rates > 650ml/min  

  

 

  

14. Set the gas flow through the system.  It is recommended that the system be calibrated at the 

same flow as that used in experimental measurements (with or without the T-piece bypass).  

The flow through the Q-S153 CO2 and Q-S102 analyzers should not exceed 650 ml/min. In the 

open loop mode, signal intensity depends inversely on flow.    

To set the flow rate through the system It is recommended that both needle valves on the Q-
P651 Gas Pump are partially restricted (as set at the factory, 1/3 of the way) and flow through 

the system is adjusted using the single valve on Q-G265 Flow Monitor.   Unlock the valve locking 

nut with the wrench provided before adjustments.  Turn the valve counter clockwise to 

increase flow or clockwise to reduce flow.  Once the flow is adjusted to the desired rate, use 

the small 8mm wrench provided in the accessory pack to lock the valves in place on the Flow 
Monitor and the Gas Pump to avoid accidental changes in the flow rate during experiments.  

Note that flow is recorded in software.  The tray holding all the sensors can then be placed 

back in the Q-Box.  

 

If higher flow  through the animal chamber is required to avoid hypercapnic levels of CO2, it is 
recommended to set up the T-piece bypass whereby a portion of the gas leaving the animal 

chamber is sub-sampled through the gas analyzers at a known rate (as set with the needle 

valve and the F250 Flow meter in the above diagram).  The excess gas from the animal chamber 
vents through the needle valve. To use the T-piece bypass, attach one side of the T-Piece to 

  

  

  

  

  

    Gas   

Source   

   Gas   

Pump   

    Flow   

Monitor   

     CO2   

Analyzer   

     O2    

Analyzer 
  

drier   

   Animal   

Cham ber   

filter   filter   

F - 250   

needle valve   

  

Locking nut    



10  

  

the outlet of the animal chamber.  Attach the other side of the T-piece to the needle valve.  

Attach the 3rd outlet of the T-piece to the inlet of the F250 flow meter and attach the outlet of 
the flow meter to the drying column in front of the Q-S153 CO2 analyzer.  Refer to the diagram 

above and the photo below.  Once the flow rate through the animal chamber is set (as 

described above) fully open the needle valve and the F250 flow meter.  Proceed to close the 
needle valve while monitoring the flow through the F250 flow meter until the flow of about 

200 ml/min is reached (2x the final flow rate).  Next, adjust the valve on the F250 flow meter 
to reduce the flow rate further until the desired value is reached i.e. 100 ml/min.    

 

 

 

 

 

 

 

 

15. The Q-G265 and S132 Sensor are factory calibrated and no additional calibrations are required.  

The Q-S153 CO2 Analyzer and Q-S102 O2 Analyzer should be calibrated at the start of each day 
of experiments.  Both analyzers have linear responses, hence they require only 2-point 

calibrations.  The first point should be zero and the second point should be a standard CO2 or O2 

concentration near the upper part of the range at which the analyzer will be used.  

Calibration of the Q-S153 CO2 analyzer (two-point calibration):  

a. Set the CO2 analyzer in the 0-5 % range. This is the default range for respirometry 

measurements.  

b. Supply CO2-free air to the analyzer by attaching the soda lime column (white) to the outlet 

of the flow monitor.  Attach the outlet of the soda lime column to the inlet of the drying 
column.  Both the soda lime and drying columns should be in a vertical position.  The outlet 

of the drying column should already be attached to the inlet of the CO2 analyzer. Soda lime 

will scrub the CO2 from the gas before it enters the CO2 analyzer and provide the zero 
reading (the first point of the calibration).  

c. From the main menu in LoggerPro Software select Experiment>Calibrate>LabQuest Mini 

1>Q-S153 CO2 Analyzer>Calibration Storage.  A dialog box will appear as shown below.  

Select the calibration storage as “Experiment File” so the calibration that was saved with 
the setup file included on the C404 disk is used.   Click “Done”. 

 

Gas flow from 

Q-G265 Flow 
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vent 
To Q-
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d. When the reading on the CO2 analyzer is stable, use the small screwdriver provided to 

adjust the “CO2 Zero” control on the analyzer to set the digital display to read 0.00 CO2. 

Clockwise turns increase the value and counter clockwise turns decrease the value. The 

reading on the CO2 analyzer display should match the reading in the software on the Q-

S153 meter. 
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e. If the zero reading is highly out of range (by more than 0.06%), or if the maximum or 

minimum position of the “CO2 Zero” has been reached (i.e. turning the control has no 
effect), use the “Coarse Zero” adjustment on the back of the instrument to bring zero 

within range.  Use the “Coarse Zero” with caution since very small adjustments result in 

large changes and there is a delay in response to changes in “Coarse Zero”.  Use the 
Coarse Zero to bring the reading close to zero. Then use the “CO2 Zero” on the front of the 

analyzer to make the final zero adjustment.  If use of the coarse aero is necessary, it is best 
to first adjust the fine zero to the middle of its range.  Do this by turning the “CO2 Zero” 

potentiometer on the front of the analyzer clockwise or counter clockwise to the end of its 

range (it will click when this is reached).  Then turn the potentiometer twelve complete 
turns in the opposite direction.  The CO2 Zero control is then centered.  

 

f. Remove the long soda lime column (white) from the gas line. Attach the “In” port of the 

Q-P651 Gas Pump to a known CO2 source (e.g. gas bag with known CO2 concentration).  

g. Wait until the CO2 analyzer shows a steady reading.  If the Q-S153 display does not show 

the concentration of CO2 in the calibration gas, adjust the display using “CO2 Span” control.  
Turning the potentiometer clockwise will increase the reading and counter clockwise will 

reduce the value displayed. 

h. If a significant adjustment was made to “CO2 Span”, return to the zero check and ensure 

the zero reading has not shifted.  It is not necessary to do the zero check while in the 

calibration mode of the software.  

i. If the readings on the Q-S153 digital display are significantly different from those on the 

Q-S153 CO2 meter in the software, first check that the correct range (5%) is still selected 

on the CO2 analyzer and the correct CO2 analyzer (Q-S153 CO2 Analyzer 5%) has been 

selected in the experimental file.  If these are correct and the readings are mis-matched, 
then proceed to calibration of the CO2 analyzer in the software as described below.   

 

Calibration of the CO2 analyzer in the software (to be used only if display readings on the 

analyzer and software readings are significantly mismatched) 

 

a. Supply CO2-free air to the analyzer by attaching the soda lime column to the outlet of the 

flow monitor.  Attach the outlet of the soda lime column to the inlet of the drying column.  

Both the soda lime and drying columns should be in a vertical position to ensure maximal 
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contact of the gas with the particles.  The outlet of the drying column should already be 

attached to the inlet of the CO2 analyzer. Soda lime will scrub CO2 from air and provide the 

zero reading (the first point of the calibration).  

b. From the menu in Logger Pro Software, select Experiment>Calibrate>LabQuest Mini 1>Q-

S153 CO2 Analyzer (5%).  A dialog box will appear as shown below.  Select the calibration 

storage as “Experiment File” so the new calibration is saved with the current file.    

 
 

c. Proceed to “Calibrate Now” in the same window (see below).  Ensure the Current 

Calibration is selected as Q-S153 CO2 Analyzer 5%<Experiment>.   

 

d. When the reading on the CO2 analyzer is stable, use the small screwdriver provided to adjust the 

“CO2 Zero” control on the analyzer (if needed) to set the digital display to read 0.00 CO2. In 

software, enter “Reading 1” as 0 and click “Keep”. 
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e. Remove the soda lime column from the gas line. Attach the “In” port of the Q-P651 Gas Pump to 

a gas bag with known CO2 concentration.  

f. If the Q-S153 display does not show the correct concentration of CO2 in the calibration gas, adjust 

the display using the “CO2 Span” control.  When the Q-S153 CO2 display shows the correct CO2 

concentration, enter that concentration as “Reading 2” in software and click “Keep” then “Done”.  

Save the experimental file under a new name so the new calibration is saved with the current 

file.  The CO2 readings in Logger Pro software should now be the same as those on the digital 

display of the CO2 analyzer. 

 

Calibration of the Q-S102 O2 analyzer:  

Note the Q-S102 analyzer measures partial pressure (kPa) of O2 in a gas and total gas pressure in the 

system.  The partial pressure of O2 will follow atmospheric pressure changes whereas the concentration 
is constant and independent of pressure variation. The analyzer O2 partial pressure reading is corrected 

in software for changes in total gas pressure to produce O2 (Pcor) reading in % units.  These corrected 

readings (see calculation below) are displayed in the software in a meter and in the graph as shown 
below.   

O2 (Pcor) = ((Q-S102 O2 )/(Q-S102 P))*100  

 

Where Q-S102 O2 is the O2 partial pressure, and Q-S102 P is the (total) gas pressure measured inside 

the QS102 O2 analyzer.   

To check and adjust the calibration of the Q-S102, follow these steps:  

a. Set the O2 analyzer in the 0-25 kPa range. This is the default range for measurements of 

respiratory O2 consumption with the Q-Box RP2LP.  Ensure the current calibration is selected as 

Q-S102 O2 Sensor 25kPa <Computer> then click “Done”. 

 

 

b. Supply O2 free-gas (e.g. N2) to the analyzer by attaching the O2-free gas source (i.e. gas 

bag) to the “In” port of the Q-P651 Pump.  As the O2-free gas enters the Q-S102 O2 
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Analyzer, the reading in the software on page 1 - (O2(Pcor)) will decrease towards zero 

(the first point of the calibration).  

c. When the reading in the software (O2(Pcor) window) is stable, use the small screwdriver 
provided to adjust the “O2 Zero” control on the analyzer until this meter display in the 

software reads 0.00 O2.  

 

d. Attach the “In” port of the Q-P651 Gas Pump to a source of gas with known O2 

concentration (i.e. gas bag with a known concentration of O2). Alternatively, dried 
room air contains 20.95% O2.  

e. When the O2 (Pcor) reading in software becomes stable, adjust the “O2 Span” control 

on the analyzer until this reading corresponds to the O2 concentration supplied to the 

analyzer.    

 

O2 reading from 

the Q-S102 in KPa  
 

 
 

 

  

  

Total gas pressure  

at the O2 sensor in  

KPa   

O2 concentration  

corrected for  
changes in gas  

pressure (%)    
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f. If a significant adjustment had to be made to “O2 Span”, return to the zero check and 

ensure that the zero reading on the analyzer has not shifted.  It is not necessary to do 
the zero check while in the calibration mode of the software.  

The Q-Box RP2LP system is now ready for use.  

16. Assemble the flow-through animal chamber (coating the o-rings of the end cap with some 
grease is recommended for easy assembly). Place the temperature probe (with O-rings) in the 

opening of the end cap as shown.  If the temperature probe requires additional sealing around 

the opening use the blue Qubitac sealant provided in the animal chamber accessory kit.  If the 
temperature probe is not used, ensure the hole is plugged with the stainless-steel rod stopper 

provided. The out-flow end cap contains a fan (blowing counter current to the gas flow) for mixing 

of gases in the animal chamber.  Attach the power supply to the fan.  

 

 
17. Place the animal in the chamber. Attach the chamber to the system as shown below and  

as explained in item #9 above for an Open-Flow system, or for an Open-Flow system with the T-

piece by-pass (larger or more active animals will most likely require this set up).  
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18. Before collecting data with LoggerPro software, select Experiment > Data Collection in the main 

menu.  The following dialog box will appear:  

  

Input experiment length and data sampling rate as required.  The default is 1 sample per sec or 

60 samples/min.  Click “Done”. 

Select: File> Save As to save the experiment settings under the file name selected during 

calibrations of Q-S153, so that the original set up file (Q-Box RP2LP Setup) is not over-written.   

19. Start data collection by clicking the green “Collect” button, and stop data collection by clicking 

the red “Stop” button (green turns red during data collection)  

 

20. Logger Pro software displays data on page 1 as they are collected in graphs, meters and 

spreadsheet columns.  Sample data from an experiment with potatoes in a 660 ml G114 chamber 
(380 g chopped into 1 cm cubes to induce wound respiration) in an open-flow system with a T-

Piece bypass are shown below.  Note the close inverse relationship between the O2 and CO2 

readings.  
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21. During the experiment, the x and y axis ranges can be adjusted by clicking on the lowest or 

highest number and typing in the desired new value as shown in the following screen.  

 

22. Upon completion of the experiment, the data can be analyzed directly in Logger Pro using the 

various analysis tools in the Analyze menu, or using icons selected in the top menu bar.  Further 
calculations can be done directly in Logger Pro on page 2 (Calculations of CO2 only, assuming 

RQ) or page 3 (Calculations of CO2 and O2 with correction for O2 and CO2 concentrations).  

The data can also be directly exported as a CSV file (File > Export As > CSV), which can then be 

opened in any spreadsheet program for further analysis and calculations.  

  
 

 

 

  



19  

  

Calculations of Metabolic Rates ( CO2 and O2):  
  

Measurements of metabolic rates can be expressed as rates of CO2 produced per unit time ( CO2) or as 
O2 consumed per unit time (  O2).  The most common units are µl/min or µl/hr.  Respiratory Quotient, 

RQ, is the ratio of CO2 produced to O2 consumed (i.e. RQ= CO2/  O2). It is directly related to the animal’s 

diet and metabolic condition.  RQ is usually less than 1.0, which means that more O2 is consumed than 

CO2 is produced.  Calculations of O2 and CO2 in the software account for this imbalance. The “Q-Box 

RP2LP Setup” file includes two pages for calculations of metabolic rates.  Page 2 is for calculations of 
CO2 only, and requires assumptions of respiratory quotient (RQ).  When only CO2 is measured (small 

animal in an open flow system) an assumption about the RQ value has to be made.  The assumed RQ 

value is assigned on Page 2 of the Experiment file.  When differential pCO2 and pO2 can both be measured 
accurately in an open flow system, (larger or more active animal) CO2 and O2 are calculated according 

to equations on page 3 of the “Q-Box RP2LP Setup” file. These equations account automatically for RQ 
values that differ from 1.0.  

  

Flow rate is measured by the Q-G265 Flow Monitor.  The Q-G265 is a mass flow meter, so readings are not 
affected by temperature and pressure changes.  Therefore, the flow rate does not need to be corrected 

for standard temperature and pressure (STP).   

  

The incurrent and excurrent CO2 and O2 concentrations are measured by the Q-S153 CO2 Analyzer and Q-

S102 O2 Analyzer during the reference and sample set up of the system, respectively. These are used to 
calculate the fractional concentrations (incurrent - Fi; excurrent - Fe) of CO2 and O2 that enters and exits 

the animal chamber. These values are obtained directly from the raw data by manually highlighting the 

data collected in the reference mode and in the sample mode then obtaining the average number from 
the statistics window as shown in the image below:  

 
 

There are two options for calculating metabolic rates.  On page 2, calculations of CO2 are made assuming 
a user assigned RQ.  This option is chosen when O2 measurements are not possible or deemed inaccurate.  

On page 3, CO2 and O2 are calculated based on the measured CO2 and O2 differentials.  Since the flow 

monitor in the Q-Box RP2LP package is upstream of the CO2 and O2 analyzers, and CO2 or O2 are not 
removed from the excurrent gas stream at any point, the following equations are used to calculate CO2 

and O2:   

 

References:  

(http://warthog.ucr.edu/WartHogPage/LAX%20website/respirometry.html)  
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Lighton, J.R.B. "Measuring Metabolic Rates: A manual for Scientists" Oxford University Press, 2008  

  

Page 2 – Calculations of CO2 only in Open-Flow System.  An assumed RQ has to be assigned. If the 
diet of the animal is not known, an assumed RQ of 0.85 is most appropriate.  

 

CO2 = (FeCO2 – FiCO2) * FR/(1 – FeCO2 * (1-(1/Assumed RQ))) 

Where FeCO2 is the fractional excurrent CO2 concentration, FiCO2 is the fractional incurrent CO2 

concentration and FR is the gas flow rate in mL/min.    

FeCO2 = eCO2 in %/100  

 

Page 3 – Calculations of CO2 and O2 in an Open-Flow System. To account for dilution, measured differential 

O2 is used in the CO2 calculation and measured CO2 differential is used in the O 2 calculations as shown in the 

following equations:  

CO2 = FR * ((FeCO2 – FiCO2) – FeCO2 * (FiO2 – FeO2))/(1 - FeCO2) 

O2 = FR * ((FiO2 – FeO2) – FeO2 * (FeCO2-FiCO2))/(1 – FeO2) 

Where FeO2 is the fractional excurrent O2 concentration, FiO2 is the fractional incurrent O2   

FeO2 = eO2 in %/100  

FiO2 = iO2 in %/100  

Calculated RQ = CO2/  O2  

FiCO 2   =  iCO 2   in  % /100   
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The following screen shows the calculations of both CO2 and O2 as well as RQ in software on Page 3 

for 380 g of chopped potatoes where both CO2 and O2 were measurable in open flow mode.  

 

 

To use calculation pages 2 and 3 the values in red columns (iCO2, eCO2, iO2, eO2, Flow Rate) must be 
entered manually.  These values are obtained from the appropriate sections of the graphs on Page 1 

showing the raw data. To select the raw data for the calculation page, use the numerous analysis tools 
available in Logger Pro. These are: Examine, Tangent, Statistics, Integral etc. which can be selected from 

the icons in the menu at the top of the screen.  Also, they can be obtained from the Analyze menu.  

 

All graphs can be selected by clicking on each graph while holding down the shift key.  Then select the 

data of interest on one of the graphs (e.g. Q-S153 CO2 values during the steady state response of the 
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animal) by holding down the shift key and dragging the mouse over the region of interest on that graph.  

Note that data on the other selected graphs for that time period will also be highlighted.  When the data 
have been selected on all the graphs, the appropriate analysis tool can be chosen (i.e. "Statistics" analysis) 

while still holding the shift key.  The statistics will then be shown in a separate window for the selected 

data on each of the graphs.  The number of decimal places or the size of the font to be displayed can be 
changed by right clicking on the analysis window as shown below.  

  

 

The mean values for each of the parameters can then be copied from the statistics windows into the 

calculation pages in the appropriate red columns.  Once the red columns with the input parameters are 

filled, the calculation columns (black) will fill automatically.  

In long experiments, it is important to measure the incurrent (reference) levels of CO2 and O2 

periodically to account for possible sensor drift.  This is done by employing the two 3-way valves that are 

shown on the diagram on pg. 6 for the calibration mode setup. The excurrent levels of CO2 and O2 for a 
sample are obtained with the 3-way valves switched to direct flow through the chamber.  

  

Installing and Running Logger Pro 3  

  

PC Users:  

  

(1) To start, a complete copy of Logger Pro 3 must be installed on the computer.  Before starting the 
installation, make sure all USB cables are disconnected from the computer.  Failure to do so may 

cause an error in the installation of the USB drivers.  
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(2) Run the installation and do not change the default destination directory.  Logger Pro 3 will be 

installed in C:/Program Files/Vernier Software/Logger Pro 3.  

(3) The setup process will automatically load the USB drivers for connecting the LabQuest Mini or other 

interfaces to the computer.  

(4) If QuickTime 6 (or greater) is not installed on the computer, install it when prompted.  QuickTime 

will allow use of the picture and movie features of Logger Pro 3.  

(5) You will be prompted to connect the LabQuest Mini or other interfaces to the computer via the USB 
connection.  The LabQuest Minis can be connected to the computer by connecting the USB1 and 

USB2 cables (in that order) from the Q-Box frame into the computer.  

(6) Click ‘Finish’ to complete the installation process.  

(7) Proceed to C404 installation (below) before opening Logger Pro with the “Q-Box RP2LP Setup” file.  

(8) Double click the “Q-Box RP2LP Setup” file (create a shortcut on the desktop once moved from the 

C404 disk for easy access) to start Logger Pro and data collection. If Logger Pro detects the two 

LabQuest Mini interfaces, the Logger Pro screen will appear with two stars (icons for LabQuest 

Minis) in the top left corner.  

  

  

 

(9) If Logger Pro cannot detect the LabQuest Mini Interfaces, a message will appear “no device 

connected” or if only one interface is detected then only one star will be shown in the software.  

Check that the LabQuest Minis are connected to the computer directly via USB plugs 1 and 2 on the 

frame of the Q-Box.  Check if the USB cables are connected to the minis.  The LED power lights on 
the Minis should be green.  No LED light indicates that power is not supplied to the Minis - check 

power connections.  A red LED indicates that power is on but there is no communication between 

the interfaces and the computer.  In this case, exit the “Q-Box RP2LP Setup” file and unplug the USB 

cables from the computer.  Reconnect the USB cables with USB1 connected first and USB2 second.  

This order is important as the computer will assign the LabQuest Minis as 1 or 2 according to the 
order in which they were connected. Allow the computer to recognize the Minis individually by 

waiting a few seconds between plugging the minis to the computer and then re-open the “Q-Box 

RP2LP Setup” file.  If the computer is having problems with assigning the LabQuest Mini interfaces 
in the correct order, then try plugging Mini 1 first then opening the experimental file and once it is 

open, plugging in Mini 2. 
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Macintosh Users:  

To start, a complete copy of Logger Pro 3 must be installed on the computer (You must be using at least 
OS 9.2).  Run the “Complete Installation” and ensure all TI GRAPH_LINK and USB cables are disconnected. 

The most recent version of Logger Pro (3) is included with this package. The following instructions are the 

same as those for PC users.  

  

C404 Custom Setup Files Installation:  

Qubit Systems’ C404 Custom Setup Files disk contains Experiment file (designed by Qubit Systems) for this 

package (Q-Box RP2LP Setup) and the manual. In addition, the manual for the LabQuest mini data 

interface is also included.  These files can be copied to user specified location on the computer and the 

experimental file “Q-Box RP2LP Setup” should be placed in an accessible location or have a shortcut 

created on the desktop to the file.  We highly recommend for the user to make a copy of the original file 

and keep it in a safe place on the computer in case the original is accidentally altered. 

 Using the Q-S153 CO2 Analyzer   

The Q-S153 CO2 Analyzer is a non-dispersive infrared gas analyzer (NDIR IRGA).  It has a gas “In” port with 

a female luer-lock connector and a gas “Out” port with a male luer-lock connector.  A length of Bevaline 
tubing with a luer-lock connector is provided to join the Q-S153 to the rest of the gas exchange system.  

The gas supplied to the IRGA passes through a sealed wave guide and vents from the “out” port.  The Q-

S153 can be used as a stand-alone analyzer in an open or closed-circuit gas exchange system. It can be 
used with other gas analyzers downstream.  However, ensure that the placement of an analyzer or 

instrument downstream from the Q-S153 does not cause a significant increase in backpressure.  
Increasing pressure significantly beyond that at which the IRGA was calibrated produces erroneously high 

readings.  
The maximum flow rate of gas into the Q-S153 should not exceed 650 ml/min. This, or lower flow rates, 
should be provided by the Q-P651 Gas pump and monitored by the Q-G265 Flow Monitor.  It is 

recommended that the user calibrate the Q-S153 at the flow rate intended to be used during the 

experiments.  If the flow rate through the animal chamber has to be maintained higher than 650 ml/min 
to avoid hypercapnic levels of CO2 in the chamber, use the T-Piece by-pass configuration whereby the T-

Piece is connected to the outlet of the animal chamber, and the outlets of the T-piece are connected to 
the needle valve and the F250 flow meter, as shown in the photo below and on pg. 8 and 9. This will allow 
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the user to sub-sample the gas exiting the animal chamber at a lower flow rate and supply it to the CO2 

and O2 analyzers while most of the gas vents via the needle valve.  

  
 

Gases entering the Q-S153 must be clean and dry, since particulate matter may absorb infrared light and 

cause erroneous readings.  Water vapour will not interfere with the IR absorption measurement of CO2, 
but water vapour will dilute the CO2 concentration.    The Q-S153 CO2 analyzer is supplied with a drying 

column containing DRIERITE.  This drying agent removes moisture from the analysis gas before it enters 

the CO2 analyzer.  Wool plugs at the base and top of the column prevent particulate matter from leaving 
the column.   

The Q-S153 CO2 Analyzer requires 12 Volts DC power to operate. A 120/220 AC power adaptor (included) 

provides 12 Volts DC.  For continuous use, leave the Q-S153 CO2 analyzer powered all the time.  Keeping 

the Q-S153 powered up will maintain the calibration constant.  

Caution:  Use only a 12 VDC adapter with the correct AC line voltages.  A 120/220 VAC 50/60 Hz to 

12 VDC adapter is supplied by QUBIT SYSTEMS.    

The Q-S153 requires a 2 to 3 minute warm-up period before the CO2 level will be displayed.  During warm-up, the 

LCD will flash numbers briefly and display the number 1.  After the unit has warmed up, the LCD will display a 

very high reading, which will slowly decline to the CO2 level in the supplied gas stream.   

For most accurate and stable readings, it is recommended that the Q-S153 be warmed up for minimum 
of 15 min to 1 hour before use.  If the Q-S153 is to be used on a regular basis, it should be powered 

continuously.  

Altitude and Barometric Pressure Correction   

The Q-S153 is factory calibrated at sea level.  When using the IRGA at elevations other than sea level, 
calibrate at the elevation at which the analyzer will be used.  If this is not possible, correct the CO2 reading 

of the analyzer according to the table below.  For example, when using a factory-calibrated unit at an 
altitude of 2,500 feet, multiply the displayed CO2 reading by 89% (1,000 ppm x 0.89 = 890 ppm actual).    
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  Altitude  

(feet)  

Pressure  

(inches Hg)  

Pressure  

(mm Hg)  

Pressure  

(psia)  

% Display  

Reading  

0 sea level  29.92  759.78  14.70  100  

500  29.38  746.04  14.43  97.97  

1000  28.86  732.84  14.18  95.94  

1500  28.34  719.64  13.92  93.91  

2000  27.82  706.43  13.66  91.88  

2500  27.32  693.73  13.42  89.84  

3000  26.82  681.04  13.17  87.81  

3500  26.32  668.34  12.93  85.78  

4000  25.82  655.65  12.68  83.75  

4500  25.36  643.96  12.46  81.72  

5000  24.90  632.28  12.23  79.69  

  

For other altitudes, use the following equation:  

Percentage of measured CO2 = [1- (4.06234 x 10-5 x Altitude in feet)] x 100  

  

Using the Drying Column and Soda Lime Column  

The Q-S153 is designed to analyze dry gas samples.  A desiccant column is provided which is filled with 

DRIERITE to dry the gas before analysis.  The column has glass wool at both ends to prevent particulates 

from being carried through the system. It is supplied ready for use.  The column should be mounted 
vertically on the Q-S153.  

DRIERITE contains an indicator that is blue when the column is functional and pink when the DRIERITE is 
saturated with absorbed water vapour.  When spent, the DRIERITE should be replaced or reconditioned.  

To recondition, remove the DRIERITE from the column and place it in a drying oven at 210 °C for 1 hour, 
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or until the blue coloration reappears.  The replacement DRIERITE is #8 mesh, order #23005 from 

DRIERITE.com.   

Magnesium Perchlorate is an alternative drying agent which is more effective than DRIERITE.   However, 
magnesium perchlorate will turn into liquid with time, so it must be changed frequently.  It is 

recommended that a trap or liquid filter is installed downstream if using magnesium perchlorate.  Qubit 

Systems is not responsible for any damage caused to any components of the Q-Box RP2LP due to 

magnesium perchlorate entering any part of the system.  

CO2-free gas can be obtained by pumping air through a column containing soda lime.  A small amount of 
glass wool should be placed at the ends of the column, and the column should then be filled with soda 

lime using a spatula.  When the column is full, it should be tapped to settle the soda lime, and then topped 

off.   The soda lime column should be used in a vertical position to ensure the gas has maximal contact 

with the crystals when flowing through the column.  

The soda lime provided with the Q-S153 has a coloured indicator to show when it is saturated with 

absorbed CO2.  The soda lime should be replaced when most of it has changed from its original white 

colour to a pale purple.  This colour change is subtle, and the purple coloration often does not persist, but 

appears as a band in the column at the junction between active and inactive soda lime.  Replacement 

supplies may be obtained from Fisher Scientific (product #S200I-3).  

  

Note: remove the soda lime column from the system once calibration has been completed.  

Warning: Soda lime can cause severe burns.  Users should read and comply with the Material Safety 

Data Sheet on soda lime.  

 Troubleshooting the Q-S153:  

 The LCD display will not stabilize during operation:  

This may indicate that the unit is not getting power.  Unplug the power cord from the unit and measure 

the DC voltage at the plug; it should be 12 Volts DC.  If using an alternate DC power source, the unit will 
operate with 12 to 19 Volts DC.  If the provided power supply is not supplying 12 Volts DC, contact QUBIT 

SYSTEMS.  

Insufficient power may cause a “1” to appear on the display:  

Check that the power supply is properly connected and is delivering +12 Volts (Centre Positive).  Check 

that the unit has been sufficiently warmed up.  

Span or zero out of range may cause “1” to appear on the display:  

Turn the “CO2 Span” all the way down (counter clockwise) and use the “Coarse Zero” on the back of the 
CO2 analyzer to display 0 with zero CO2 gas flowing through the system.  Once the zero display is read, 

attach a known CO2 concentration to the system and use “CO2 Span” to adjust the display on the CO2 

analyzer to the correct CO2 concentration.  Return to the zero CO2 check with zero CO2 gas running 
through the system, and if necessary, make small adjustments with the “CO2 Zero”.  
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Ensure no material (liquid or dust) has entered the analyzer:  

If material has entered the analyzer, it will block the internal light path and “1” will be shown on the 

display.  The unit will need to be returned to QUBIT Systems for repair.  

Ensure the Gas Flow Path in the Analyzer is Open:  

Check that there are no internal leaks in the analyzer.  Connect a 10ml syringe to a tube on the “Out” port 
of the CO2 analyzer and plug the “In” port.  Pull a slight vacuum with the syringe.  If there is no leak, the 

plunger should not move.  If there is an internal leak, contact QUBIT Systems for further instructions.  

If the analyzer is exposed to extreme pressures, a leak can result.  

Ensure the Pump is not leaking.  

A faulty pump can leak room air (possible high ppm CO2) and increase the CO2 reading.  To test the pump, 

turn it on and plug the inlet.  Connect a tube to its outlet and place the tube in a glass of water.  There 
should be no bubbles.  If there are bubbles, the pump is leaking internally and should be repaired or 

replaced.     

Ensure the Soda Lime CO2 Scrubbing Column is used to provide Zero CO2 gas to the analyzer:  

Do not confuse the soda lime column with the drying column filled with DRIERITE.  Soda Lime is white, 
whereas DRIERITE is blue.  If the drying column is mistaken as the CO2 scrubbing column, CO2 may enter 

the analyzer since DRIERITE absorbs some CO2 and can release it slowly thereby slowing response time.  

If unsure of the condition of the Soda Lime in the column, replace it with new Soda Lime or use an 

alternate zero CO2 source such as pure N2 gas.  

 Check Calibration  

If the CO2 Span control has been adjusted without following a full calibration procedure, the analyzer must 

be recalibrated using a zero gas mixture and a gas mixture with a known CO2 level.  See the CO2 analyzer 
calibration section of this manual for the correct procedure.  

The CO2 readings on the display of Q-S153 are different from those in Logger Pro  

If the CO2 values displayed on the Q-S153 CO2 Analyzer are very different from those displayed in the 

Logger Pro file, first check that correct range for the CO2 analyzer has been selected both in software and 

on the analyzer - the default should be 5 %.  If the ranges are selected correctly, check that the LabQuest 

Mini interfaces have not been reversed (check that values displayed in LoggerPro software for other 
sensors are correct).  If the LabQuest Minis have not been reversed, then the CO2 Analyzer requires a new 

calibration in software.  Proceed with calibration instructions outlined above on pg. 12.  If the LabQuest 

Minis have been reversed follow the instructions below on pg. 34 on how to fix the problem.  

  

Using the Q-S102 O2 Analyzer  

The Q-S102 O2 Analyzer contains an O2 sensor which is a galvanic cell (a lead-oxygen battery) consisting 

of a lead anode, an O2 cathode, and an acid electrolyte.  It also incorporates an O2-permeable Teflon FEP 
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membrane with a gold electrode bonded to its surface.  Oxygen diffusing through this membrane is 

reduced electrochemically at the gold electrode.  A resistor and a thermistor (for temperature 
compensating diffusion across the Teflon membrane) are connected between the anode and the cathode. 

The output of the instrument is proportional to the current flowing through the resistor and thermistor.  

This current is proportional to the partial pressure of O2 in contact with the Teflon FEP membrane.  The 
signal from the oxygen sensor is transmitted to the computer via the LabQuest Mini (i.e. Q-S102 O2).  The 

Q-S102 O2 Analyzer has two analog signal outputs, one for O2 and one for total gas pressure at the O2 
sensor.  The total gas pressure reading from Q-S102 are used in correction of the O2 signal in kPa to O2 in 

% (O2 (Pcor)).  This is done automatically in the software.     

 

The galvanic cell is housed in a brass cylinder for greater temperature stability and more stable O2 signal. 
Pressure (Q-S102 P) is measured at the O2 cell and is displayed on page 1 in a meter and a graph.  This 

pressure value is then used in software to convert the partial pressure (kPa) of O2 (Q-S102 O2) to a 

concentration (%) (O2 (Pcor)) which is independent of pressure.    

O2 (Pcor)=((Q-S102 O2)/(Q-S102 P))*100  

The pressure corrected concentration is displayed in a meter and a graph.   

 

 

  

Total gas pressure  

measured at the  

O2 sensor in kPa   

O2 reading  
from Q - S102 in  
KPa   

Avg. O2 in % corrected  

for Pressure   
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The maximum flow through the Q-S102 O2 analyzer should not exceed 650 ml/min.  The minimum flow 

through the O2 analyzer should not decrease below 5mL/min to avoid local depletion of O2 at the 
membrane of the sensor.  The analyzer should not be exposed to pressures that are above 20 PSIG or 

below 10 PSIG, or the damage to the sensor can result.   The expected life of the O2 Analyzer’s galvanic 

cell is 3-5 years.  If it is impossible to adjust the O2 signal amplitude by adjusting the span, a new sensor is 

necessary.  Contact Qubit Systems to obtain the replacement galvanic cell and instructions on its 

replacement.   

 The Q-S102 is supplied with its own drying column filled with DRIERITE.  When used in series with the Q-

S153 CO2 Analyzer, only one drying column is necessary (in front of the Q-S153) unless the sample gas is 

very wet.  When using the Q-S102 in a stand-alone mode, gas should be dried before entering the O2 

Analyzer to avoid dilution by the water vapour. Place the drying column in the bracket mounted on the 

analyzer and connect it to the “In” port via the blue particulate filter (25µm). Check the filter frequently 

to ensure that it is not plugged.  Plugged filters will result in reduced gas flow to the analyzer and should 

be replaced.  

Troubleshooting Q-S102 O2 Analyzer  

If the O2 signal can no longer be adjusted with the “O2 Span” and the analyzer has been used for 3-5 years, 

the galvanic cell should be replaced.  Contact Qubit Systems for instructions on ordering the new cell and 

on the replacement procedure.  

If significant periodic jumps (0.5-1kPa) in the O2 readings are observed, this may indicate pressure 

damage to the Teflon membrane inside the sensor cell.  If the signal shows unexpected drift, check for 

other damage to the membrane by removing the Q-S102 O2 Analyzer from the Q-Box tray by unscrewing 

the two bolts on the back that hold the analyzer in place.  While monitoring the O2 readings, tilt the 

analyzer 90 degrees.  If there is a large change in the signal following the tilt, the Teflon membrane is likely 

damaged.  In case of damage to the membrane, the galvanic cell should be replaced.  Contact Qubit 

Systems for replacement instructions.    

If small pulses in the O2 readings are observed when passing a stable O2 gas through the analyzer, this 

may indicate pressure changes in the system resulting from unstable gas delivery.   First, check the system 
for obstructions or restriction in the gas lines.  Second, check the O2 analyzer by unplugging the gas supply 

line from it.  The reading should become stable after detaching the gas supply line.  A stable reading when 

no gas is flowing through the analyzer, indicates that gas delivery to the analyzer is the problem.    

Unstable gas delivery may be due to the Q-P651 Gas Pump.  In an open-flow system, both needle valves 
on the Q-P651 Gas Pump should be partially restricted (as set at the time of manufacture, about 1/3 

closed from the fully open position) and the flow should be adjusted via the needle valve of the Q-G265 
Flow Monitor.    
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Using the S132 Temperature Probe    

The temperature sensor is a semi-conductor device mounted on the end of a stainless-steel probe.  It is 
inherently linear with an operational range from –40oC to +125oC.  The temperature sensor should not 

require calibration; however, it is possible to calibrate it in the Logger Pro software using the menu 
commands Experiment>Calibrate.  The sensor is recognized automatically, and calibration is loaded when 

the “Q-Box RP2LP Setup” file is opened.  The sensor is mounted on a stainless-steel support, which fits 

through the temperature sensor port of the animal chamber.  The temperature sensor port in the 

chambers must be plugged with the provided plug when the sensor is not in use.  

Using the G122 Gas Bags  
The heat-sealed, 30 L gas bags are made from a gas-impermeable nylon-polyethylene laminate.  Tygon 

tubing is attached to each bag by a luer-lock fitting.  The fitting on the other end of the tubing attaches 
directly to the fittings on the Q-P651 Gas pump.  These bags can be filled with air from a compressor (or 

another gas mixture) to provide a constant source of CO2. For long experiments, outside air (constant 400 

ppm CO2) should be used since compressor refills may have variable CO2 concentration if room air is used. 
Inside air can vary several hundred ppm in CO2 due to human activity.  Bags should not be overinflated, 

as this can cause weakening of the seams and eventual leakage.  After use, the bags should be fully 
deflated, preferably by attachment to a vacuum-line or pump.  

    

Using Q-P651 Gas Pump  

The Q-P651 Gas Pump is a 3L/min (no load) pump.  It is used in this Package to carry gas through the 

system.   The Q-P651 Gas Pump is delivered with pre-set pump speed of 2L/min as part of the Q-Box 

system, and together with the Flow Monitor it delivers the gas at a flow of about 600mL/min.  The two 

needle valves on the back of the pump are locked in position to maintain this flow of air through the 

system. The flow rate through the system should be adjusted with the needle valve of the Flow Monitor 

Q-G265.   Please remember that if flow rates higher than 650ml/min need to be used then the By-pass T-

Piece needs to be employed as described on pg. 7-10. 
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If the pump is used in a stand-alone mode and the pump speed needs to be adjusted, it can be done with 

the two needle valves on the back.  To set the flow rate with the gas pump, initially fully open both needle 

valves on the back of the Q-P651 Gas Pump (turn counter-clockwise). Adjust the flow rate down to about 

twice the required rate using the valve beside the pump outlet (“Out”).  Second, reduce the flow further 

to the required rate with the needle valve on the Gas Pump across from the “In” gas port (see photo 

below).    

 

Turn the valves on the gas pump clockwise to reduce the flow or counter clockwise to increase the flow.  

Once the flow is adjusted to the desired rate, use the small wrench provided in the accessory pack to lock 

both valves of the gas pump with the outside nut in place to avoid accidental changes in the flow rate 

during experiments.    

  

 
  

  

  

  

Locking nuts on both  

needle valves should  

be tightened to avoid  

accidental changes in  

flow rate   
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A249 Battery Pack (optional) 

 

The A249 battery pack is composed of two Voltaic V88 Universal Batteries.  The batteries are Lithium Polymer and 
can be charged directly via an AC charger or from a car battery via a DC charger (included).   The two batteries that 

power the Q-Box supply a maximum of 177 Watt hours of power.  Both batteries together, or one at a time are 

hooked up to the Q-Box power outlet via the split cable provided.  The use of A249 Battery Pack allows field 

operation of the Q-Box RP2LP or any other Q-Box package for up to 11hr (without the lap top computer).  Each 

Voltaic battery has one “Out” port for plugging in the Q-Box power cable and an “In” port for plugging in the AC or 

DC charging adaptor. The voltage output from the battery to the Q-Box has to be set to 12V. This is selected by 
pressing the black button on the top of the batter for 3 sec and then again for selection of 12V.  It is important to 

set up 12V output before the battery pack cable is plugged into the Q-Box.  Settings higher than 12V may damage 
the Q-Box. 

Once the battery pack is connected to the Q-Box the output voltage cannot be accidently changed. 



34  

  

                 

 

 

  

Troubleshooting LabQuest Minis  

LabQuest Mini 1 and 2 are switched  

If the sensors show unusual values, Logger Pro software may have confused LabQuest Mini 1 with 

LabQuest Mini 2.  To rectify this situation, follow these steps:  

Close the “Q-Box RP2LP Setup” file.  Unplug the two USB cables from the frame of the Q-Box.    

   

Input from charger 

Output to Q-Box via 

battery power cable 

 

 Select 12V (press 
down for 3 sec until 

selection is flashing 

press again to 
change voltage 

selection to 12V 
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First, reconnect one cable into the USB 1 outlet on the frame, then plug the second cable into the USB 2 

outlet.  As each LabQuest Mini is recognized by the drivers, there may be an audible beep and the indicator 
LED light on the LabQuest Minis will change from red to orange.  Reopen the “Q-Box RP2LP Setup” file 

and proceed to assigning the sensors to appropriate channels on the two LabQuest Mini interfaces as 

follows:  

a. Ch. 1 LabQuest Mini 1 = Q-S153 CO2 Analyzer 5%  

b. Ch. 2 LabQuest Mini 1 = Q-S102 Analyzer pressure  

c. Ch. 1 LabQuest Mini 2 = Q-S102 O2 sensor (25kPa) 

d. Ch. 2 LabQuest Mini 2 = Q-G265 Flow Monitor 2LPM  

Note: The LabQuest Mini 1 automatically recognizes the Stainless Steel Temperature probe (S132) in 

channel 3.  

 

If the computer continues to assign the Lab Quest mini interfaces in the wrong order, then follow these 

steps to fix the problem:  first plug in USB 1 cable to the computer and open the experimental file Q-Box 

RP2LP Setup, once the single star is observed in the top menu then plug in USB 2 cable to the computer 

and wait for the second star to appear as the software recognizes the second mini.  The system should 

now be set up correctly to select the individual sensors as shown in the window above. 

Using Q-G265 Flow Monitor  

The Q-G265 Flow Monitor has been factory calibrated and should not require further calibration.  
However, if after extended use the flow values appear erroneous, the zero may have drifted.  To reset 

zero, adjust “Flow Zero” on the front of the instrument using the small screwdriver provided with the 

package when no gas is flowing through the flow monitor.  Make this adjustment with no gas running 

through the system, until a zero flow value is displayed in Logger Pro.  Do not accidentally adjust the 

“Flow Span”.  If “Flow Span” needs adjusting, a calibrated flow standard must be used (for example a 
Mass flow Controller set at a known flow rate of air).  
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It is recommended to adjust the flow rate through the Q-Box using the needle valve on the back of the 

flow monitor.  The flow is increased by turning the valve counter clockwise and decreased by turning it 

clockwise. Once the flow is set lock the ring on the needle valve with the small wrench provided to avoid 

accidental changes to the flow rate.  The data cable from the analog output labeled “Flow” is plugged into 

the data interface and the flow data is displayed in the software.   

  

    

 

Specifications of Q-S153 CO2 Analyzer  
Operating principle          Non-dispersive infrared  

Gas sampling mode          Flowing gas stream, sealed chamber  

Maximum gas flow rate         650 ml/min  

Measurement range (LCD display)      0-10 %  
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Analog output, low sensitivity        0-10 %  

Analog output, high sensitivity       0 -5 %  

Accuracy (assumes accurate recent calibration)   0.3% of FS  

Resolution            0.01%  

Repeatability (assumes stable atm press and temp)  Better than ±1%  

Maximum drift (per year)        ±0.5%  

Response time (@ 250 ml/min; to 95% of final value)  ca. 20 sec  

Warm up time (@ 22oC)         ca. 5 min  

Output (linear) for Low Sensitivity setting    0-5 VDC for 0-10 %  

Output (linear) for High Sensitivity setting    0 -5 VDC for 0-5 %  

Calibration adjustments         Zero and Span  

Operating temperature range        0 to 50oC  

Storage temperature range        -40 to 70oC  

Operating pressure range        ±1.5% local mean pressure  

Humidity range           5 to 95% RH, non-condensing  

              (Recommend drying gas stream)  

Pressure dependence          +0.19% reading per mm Hg  

Power requirements          12 VDC via 120 VAC/60 Hz adapter  

Current requirements          175 mA average, 450 mA peak  

Dimensions (cm)          (H x W x D: 5.5 to 9.5 x 9.5 x 17cm)  

Weight             1kg  

Warranty            1 year limited  

  

  

    
Specifications of Q-S102 O2 Analyzer:  

Operating principle        Acid Electrolyte, Teflon Diffusion Membrane  

Detection Range        0-25kPa and 0-100 kPa O2 (Linear)  

Resolution         ±40 ppm   

Accuracy         ± 0.21% of Full Scale  

Response Time (90%)       12 Seconds  

Life Expectancy of O2 sensor  

Easy sensor replacement  

   3-5 years   

Influence by Other Gases      Ammonia and Ozone  

min flow         5 ml/min  

max flow          650 ml/min  

Built in total gas pressure reading at the sensor (for pressure correction in the software)  

 Pressure Range        0.5 atm to 1.5 atm  

 Pressure Effect         Output voltage changes proportionally   

 Shock Resistant        to 2.7 G  

Avoid strong vibration  

 Operating Temperature      5 to 40oC (Effective range)  

 Weight           1.35 kg  

 Dimensions (cm)        (H x W x D: 5.5 to 9.5 x 9.5 x 17)  
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 Output          0 to 5 volt  

 Power Supply         12 Volts  

 Warranty        1 year limited  

  

    

Qubit Systems Warranty Information  

QUBIT warrants all its instruments to be free from defects in materials or workmanship for a period of 

one year from the date of invoice/shipment from QUBIT.   

If at any time within this warranty period the instrument does not function as warranted, return it and 

QUBIT will repair or replace it at no charge. The customer is responsible for shipping and insurance 

charges (for the full product value) to QUBIT.  QUBIT is responsible for shipping and insurance on return 
of the instrument to the customer.      

No warranty will apply to any instrument that has been (i) modified, altered, or repaired by persons 

unauthorized by QUBIT; (ii) subjected to misuse, negligence, or accident; (iii) connected, installed, 

adjusted, or used otherwise than in accordance with the instructions supplied by QUBIT.    

The warranty is return-to-base only, and does not include on-site repair charges such as labour, travel, or 
other expenses associated with the repair or installation of replacement parts at the customer’s site.   

QUBIT repairs or replaces the faulty instruments as quickly as possible; maximum time is one month.   

QUBIT will keep spare parts or their adequate substitutes for a period of at least five years.   

Returned instruments must be packaged sufficiently so as not to assume any transit damage. If damage 

is caused due to insufficient packaging, the instrument will be treated as an out-of-warranty repair and 

charged as such.   

QUBIT also offers out-of-warranty repairs. These are usually returned to the customer on a cash-on 

delivery basis.    

Wear & Tear Items are excluded from this warranty. The term Wear & Tear denotes the damage that 

naturally and inevitably occurs as a result of normal use or aging even when an item is used competently 

and with care and proper maintenance.  

Return Procedure  

Before returning any instrument to QUBIT:    

Consult the operating manual or contact Qubit to ensure that the instrument(s) is in fact faulty and has 

not just been set up improperly.   

Contact QUBIT before sending anything back.  We will issue an RMA number and provide shipping 

instructions.   QUBIT will refuse any goods that are returned without an RMA number, or which are sent 
in a manner outside of QUBIT’S stipulations.  
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If you have encountered a program failure, we need a printed copy of any faults you have seen, including 

how to reproduce them.  Include these in the return package along with your mailing address.   

Include a copy of the Invoice on which the product was shipped to you.   

All returns must be shipped prepaid.  Unpaid packages will not be accepted.   

In case of questions contact QUBIT by  

E-mail: info@qubitsystems.com,  by 

phone: (01)-613 384 1977,  or by  

fax: (01)-613 384- 9118.  

  

  


